
XAVIER COLLEGE PREPARATORY HIGH SCHOOL  
SUMMER READING Project 2026 - Grade 10 (AP Seminar) 
 
Dear Incoming AP Seminar Student,  
 
We hope that this letter finds you well and anticipating a rewarding sophomore year. We hope 
that you will have many good experiences and make many good decisions before we see you 
again in August. One of those decisions we would like to help you with is the decision to remain 
engaged in  academic activity that will benefit our efforts in AP Seminar. 
 
Your work this summer will include two parts.  The first part is completion of the summer 
assignment expected of all entering 10th grade students. The second part is specific to AP 
Seminar students and must be completed in order to stay enrolled in the class in the fall. 
 
Part I (All 10th grade students complete): 
You will read the sophomore summer text (see below) and complete the attached 
assignment on literary terms. This novel has been selected for its interest level and readability 
as well as for its challenging, compelling content. In short, you should expect to think, but the 
book should be fun to read. You will be expected to take a substantive test on it in the first week 
of classes. Please carefully read the book in preparation (think about themes, symbolism, and 
characterization).  
 
Required Book for 10th grade English:  
 
● The Art of Racing in the Rain by Garth Stein (Fiction) (expect 5 hours)​

A heart-wrenching but deeply funny and ultimately uplifting story of family, unconditional 
love, loyalty, and hope. It is a beautifully crafted and captivating look at the wonders and 
absurdities of human life...as only a dog could tell it. 

 
Assignment:  
●​ Your task is to read the assigned book The Art of Racing in the Rain, reading for and taking 

notes for characterization and plot. Your job when you return to school is to prove that you 
have read and understand the text.  

 
●​ You will also be expected to work with the list of literary terms (end of document), noting 

that we supply you with  the definitions. Your assignment is to print the assignment and then 
find and handwrite an example for EACH term. You are not expected to find these 
examples in the assigned books; rather, you should research or give your own example. You 
will be required to hand in the completed list of literary terms on the first day of class. 
This list will be something you have for reference as we analyze the different texts we'll be 
studying throughout the school year.  (Please find the list of terms at the end of this 
document.) 

 
 
 
 
 
 
 
 
 



 
Part II asks you to read, watch, research, and present.  These activities will prepare you 
for the rigorous expectations of the AP Seminar class. (Expected total time:  22 hours) 
 

Part II: Anchor Texts (Read) 
I. Read: AP Seminar Anchor Text:  George Orwell’s Animal  
Farm (expected 4 hours)This novella, published in 1945, is an anti-utopian satire. A political fable based 
on the events of Russia’s Bolshevik revolution and Joseph Stalin’s betrayal of the effort, the book features 
farm animals who overthrow and chase off  their human masters, but who also experience the downfall of 
democratic aspects of their efforts as they grapple with power. Students must submit their books to the 
instructor on the first day of class to receive a grade on book annotations - please make in-text notes on 
items including: setting, characters (protagonist/antagonist), conflict, themes, symbols, climax and 
resolution, and highlight  impactful passages. You can use stickies or write on the page itself. Students 
will need a physical copy of the book. 
 

​ Check when completed  
 
II. After you read Animal Farm, think about the issue of power and government, and consider the following 
thematic question, which is based off of the theme of personal freedom and democracy explored in the novel: 

Question: To what extent are Americans truly free in a society shaped by mass media? 

Now ask yourself this guiding research question: → Are the ideals of democracy working in our 
mediated American society?  
 
II. Read and Annotate: Articles on Democracy and Media (expected 3 hours) (To fully consider this 
question, take notes on the following articles and videos - you will hand in these notes along with your 
presentation. Notes can be handwritten or typed.  Any typed document must be submitted with editing 
privileges - beware of AI writing, which will not receive credit:  
 
These articles (along with Animal Farm, are called “stimulus materials” to stimulate your thinking.  They should help 
you to think about the issue of democracy and media, and you should be able to use  some of this information for your 
researched presentation. 
 
Article 1: "Mapped: The State of Democracy Around the World" Visual Capitalist, May 13, 2024  
Article 2: “Young Adults and the Future of News” Pew Research, December 3, 2025 
Article 3: Misunderstood mechanics: How AI, TikTok, and the liar’s dividend might affect the 2024 
elections   
 

​ Check when completed  
 

 
 
 
 
 
 
 
 

https://www.britannica.com/art/fable
https://www.britannica.com/topic/Bolshevik
https://www.visualcapitalist.com/the-state-of-democracy-around-the-world/
https://www.pewresearch.org/journalism/2025/12/03/young-adults-and-the-future-of-news/
https://www.brookings.edu/articles/misunderstood-mechanics-how-ai-tiktok-and-the-liars-dividend-might-affect-the-2024-elections/
https://www.brookings.edu/articles/misunderstood-mechanics-how-ai-tiktok-and-the-liars-dividend-might-affect-the-2024-elections/


 
 

Part III. Watch 
 
Long Companion Videos (more stimulus materials - expected 4-5  hours) 
(Take Notes to submit and to show you viewed - include in Works Cited if used.) 

1.​ Fights Over American Democracy Reach Back to the Founding Era | Retro Report 
Contributes to a documentary (2024) (9 mins)  

2.​ Dismantling Democracy: America, Land of the Free? (2020) 
“In the first of this three-part series, we dive into the history of democracy, its birth and the 
United States' unique take on this form of government. The episode takes a look at some uniquely 
American challenges that limit American democracy such as hyperpartisanship, negative 
partisanship, institutional constraint.” (55 mins) 

 
3.​ Dismantling Democracy: The Way Forward (2020) 

 
“In the final episode of this  
three-part series, we explore  
what is needed and what  
may need to change to preserve American democracy. By looking at the basic pillars of a 
democratic society -- freedom of speech, free and fair elections and a focus on human rights -- we 
are challenged to rise to the occasion, participate in civic discourse and take action.” (55 mins) 
 

4.​ The Facebook Dilemma (2018) 
​ “The promise of  
Facebook was to create a more open and connected world. But from the  

company’s failure to protect millions of users’ data, to the proliferation of “fake news” and 
disinformation, mounting crises have raised the question: Is Facebook more harmful than helpful? 
This major, two-night event investigates a series of warnings to Facebook as the company grew 
from Mark Zuckerberg’s Harvard dorm room to a global empire. With dozens of original 
interviews and rare footage, The Facebook Dilemma examines the powerful social media 
platform’s impact on privacy and democracy in the U.S. and around the world.” (55 mins) 

 
5.​ Fake: Searching for Truth in the Age of Misinformation (2020) 

​ This PBS program  
discusses the media landscape and its impact on our ability to live out  

democratic principles.  Fake news, social media, branding, and the need for media literacy  are 
discussed.  (56 mins)​  

Short Companion Videos (expected 45 mins) 

1.​ Tech, trust, and the competitive edge: Kat Duffy, Frank McCourt, Eli Pariser  
May 28, 2025  “As our online and offline worlds converge, trust in digital systems is breaking 
down. From fragmented platforms to rising polarization, today’s digital spaces fail to deliver their 
public promise. This conversation explores rebuilding trust and designing a digital future rooted 
in agency, connection, and shared purpose. Panelists will offer bold visions for what’s next, the 
systemic changes required to get there, and the role leaders across sectors must play in shaping 
more inclusive and resilient digital spaces.” (15 minutes) 

 

https://www.youtube.com/watch?v=ZZeqIS8CP7U
https://www.pbs.org/video/dismantling-democracy-america-land-of-the-free-mujgbp/
https://www.pbs.org/video/dismantling-democracy-the-way-forward-a0owwt/
https://www.pbs.org/wgbh/frontline/documentary/facebook-dilemma/?utm_source=chatgpt.com
https://www.pbs.org/video/fake-searching-for-truth-in-the-age-of-misinformation-jczifr/
https://youtu.be/JXCUUhBIEAw?si=Orvn0gUpXx8d3LjT


2.​ Crash Course Media Literacy clips  (26 mins) 
a.​ Introduction to Media Literacy #1 (2018) (10 minutes) 
b.​ Media and the Mind #4 (2018)   (9 mins) 
c.​ Future Literacies #12 (2018)   (7 mins) 

​ Check when Viewing is completed  
IV. Research (expected 4 hours): Conduct additional  research of your own on issues related to  
American democracy and how it is working in our mediated society.  (Annotate- include in Works Cited 
if used; use scholar.google.com for your research as a rule.) 

1.​ NOW focus on some aspect of this summer’s theme (highlighted) and research more specifically! 
Conduct research using Google Scholar (scholar.google.com).  Research should not be done in 
regular Google UNLESS you are looking for a government  website – .gov or .org.  You may only 
use TWO reputable news sources max.    

a.​ You can search terms like: Social Media and democracy, American media and 
surveillance, Media literacy and democracy, etc. 

b.​ Notice the topics that come up with your searches.  Choose your topic of interest from 
there and try to focus your answer to the question narrowly. (A few specifics related to 
democracy and media in America  to get your started: Fake News, TikTok’s role in voter 
turnout, Hacking  elections, algorithms and surveillance…there are SO many topics 
related to democracy and the media in America.  You must find at least FIVE sources on 
your own that speak to your narrowed topic of interest!  These five sources should be 
annotated for the key messages you will use for your understanding.  THREE of the 
sources should be from a research journal.  You will submit your annotations.  If the 
journal article is very long (some are 30 pages), you should at least read the introduction, 
results, and discussion sections so that you know what the researchers found and so that 
you can report their findings. If the research is not going to help you, don’t annotate!  
Move on!  Find something that WILL help. 

c.​ Save and format your sources on a Works Cited page 
To organize your research on your topic of interest:  

i.​ Open a Google Doc - you will be giving me access to this document when we 
return to school 

ii.​ Sign in to your Google Account through Xavier and research using 
scholar.google.com. You can star articles you want to save (see the save/star 
button under each article).  

iii.​ Spend time only on articles that offer a full-text PDF. Abstracts are not allowed 
to cound toward your sources. 

iv.​ You can cite any article from Google Scholar in MLA format. Copy and paste the 
citation into your Works Cited page. Use MLA style for this. 

v.​ Use the Tools → Citations  tab on Google Doc to create citations for your Works 
Cited when you can’t get the citation from the journal. 
 

2.​ Based on all you have learned and recorded: Are the ideals of democracy working in our 
mediated American society?  Your answer to the question should be complicated and should put 
forth either a problem that needs a solution OR a position you are taking that begs for a resolution 
of some sort.  This is not just a report!  

a.​ MY EXAMPLE:  I am really interested in how news has migrated toward entertaining 
us rather than strictly informing us in recent years.  I would do research to find out if 
there are links to voter turnout and political activism..  I don’t know what I would find, 
and I might change my mind, but if I had to argue without doing the research, I would 
make the argument that entertainment journalism has contributed to a decline in 
democracy as people have started seeing world issues as less serious. If I am right, then 
this is a problem if voting has declined because democracy is built on getting people to 
participate.  I need to suggest a solution: My solution would be guided by research, of 
course, but I might suggest early education programs for kids to teach them the 

https://www.youtube.com/watch?v=AD7N-1Mj-DU&utm_source=chatgpt.com
https://www.youtube.com/watch?v=TAdkzxB4WFo&utm_source=chatgpt.com
https://youtu.be/Q_aXzpeam0s?si=pn9ghgSoAdFh_qWy
http://scholar.google.com


importance of civic engagement. Maybe there are ways our entertainment industry could 
do more to encourage people to take civic engagement seriously. 

b.​ Tips: Ask yourself: Who benefits? Who is left behind? Is the reality different from the 
ideal that people talk about? What is being done?  What might be done better? 
Remember: You are making an argument.  It is an argument if someone can disagree.  
You should speak to the counterargument, as well.  Finally, what is a solution or a 
resolution for the problem you are arguing? 

​ Check when completed  
V. Create a Presentation on Your Findings (expected 3-4 hours):  Your presentation must be 
professional and answer the question: Are the ideals of democracy working in contemporary American 
society? Remember there needs to be a focused aspect of American society that you can reflect on. 
Presentations will be delivered during the first week of school and must be no longer than 4 minutes long. 
(11-15 slides) – Try https://slidesgo.com/research!  

1.​ Slide 1: Include a Title slide to introduce the topic/issue you chose to research on your own and 
your name 

2.​ Slide2: Include a Table of Contents  
3.​ Slide 3: Include your Research question – To what extent are the ideals of democracy working 

in our mediated American society? This can be a separate slide. 
4.​ Slide 4: Stimulus Materials connection – from Parts 2 and 3 – To find your connection to your 

research argument, Include a theme from Animal Farm that is connected to our class question, as 
well as  a connecting theme from two other stimulus materials from Parts 2 and 3 above.  These 
stimulus materials should show how you have connected them through a common theme to help 
guide your Animal Farm (i.e., the surveillance from Big Brother through the telescreen).  I could 
show a connection with The Facebook Dilemma and surveillance through algorithms and 
Misunderstood mechanics: How AI, TikTok, and the liar’s dividend might affect the 2024 
elections.  Here I am connecting the idea that surveillance through social media platforms impacts 
voting negatively.  With these stimulus materials in mind, I will identify the argument that Social 
media algorithms are set up to sway election outcomes and must be dealt with through legislation  
to protect democracy.  Now I have an argument.  

5.​ Slide 5:  Specifically state your argument or thesis. 
6.​ Slide 6: Include Context (i.e., background).  Make sure you explain the importance or “so what” 

of the issue or problem you identified! 
a.​ You will need to make sure you identify sources you are using and context for your 

research to bring credibility. These are visual or verbal citations to help your listener 
believe your statements. Visual citations appear on the slide, i.e., (Carr 2005).  Verbal 
citations are spoken (i.e., Dr. Carr, a media researcher at the University of Georgia, says 
that a desire to maintain positive versions of corporate identity drives companies like 
Coca Cola to adopt prosocial advertising and environmental policies.)   

b.​ You can include more than one slide to help explain context 
7.​ Slide 7: Claim 1: The first reason supporting your argument - must use research throughout 

(visual or verbal) Include in Works Cited. 
8.​ Slide 8: Claim 2: The second reason supporting your argument about your topic -  - must use 

research throughout (visual or verbal) Include in Works Cited. 
9.​ Slide 9: Claim 3: A counterclaim to address your democracy topic argument. You should offer 

your answer to the counterclaim -  - must use research throughout (visual or verbal) Include in 
Works Cited. 

10.​ Slide 10: A proposed solution or resolution that might work for your problem (found in research) 
but that you do not regard as highly as your final solution or resolution 

11.​ Slide 11:  Your determined solution or resolution to the issue you identified - this is the one you 
are arguing is the best.  It can be a combination of a couple of solutions. 

12.​ Slide 12: Conclusions you are drawing after the research. What limitations do you see, and what 
are implications if your solution is adopted?  i.e., what would happen for the better? 

13.​ Works Cited/Bibliography slide 
a.​ Use hanging indent for works cited (see example below) - if you only provide links, you 

cannot receive full credit. 

https://slidesgo.com/research


 

​ Check when completed  
 
 
 
 
 

Formatting for Works Cited using Hanging Indent –  Here’s How: 

1.​ Alphabetize the entries. Highlight all entries and go to Format → Align & Indent → Indentation 
Options → Special Indent → Hanging (Works Cited will be properly indented/formatted)’ 

 

 

Example of Proper Formatting: 

 

Works Cited 

Dvořáková, Jana. "The Influence of the Spanish Civil War on George Orwell and his Novels Animal Farm and 

Nineteen Eighty-Four." 

Rodden, John. "Decency and democracy: George Orwell,“the aspiring plebeian”." Prose Studies 12.2 (1989): 

174-192.  

​ Check when completed  
 

******************** 
Late work cannot be accepted in AP Seminar for the summer assignment. If you run into trouble with a 
part of the assignment, please feel free to reach out to me (email Dr. Carr at tcarr@xavierprep.org). I will 
be able to get back to you within a day or two. Students who do not complete the summer assignment will 
be asked to enroll in either English II Honors or English II.  I look forward to seeing you soon! It will be a 
GREAT year! 
Your teacher,  
Dr. Carr 
 
 
 

See below for Literary Terms assignment! 
 
 
 
 
 
 
 
 
 

mailto:tcarr@xavierprep.org


 
 
 
 
 
 
 
Name: ​ ​ ​ ​  
AP SEMINAR 
Date:  

Literary Terms with Definitions 
 
The following is a list of 38 selected terms that could assist with literary analysis.  Please 
keep this list available, if not memorized, throughout the year. Find and handwrite an 
example for EACH term. You are not expected to find these examples in the assigned book, but 
should research or give your own example. In any case, make sure that it is accurate and correct. 
You will be required to hand in the completed list of literary terms ON THE FIRST DAY OF 
CLASS. (Expected time: 1.5 hour) 
 
Allegory: a story, poem, or picture that can be interpreted to reveal a hidden meaning, typically 
a moral or political one. 

Ex: 

Alliteration: the occurrence of the same letter or sound at the beginning of adjacent or closely 
connected words. 

Ex:​  

Allusion: a brief and indirect reference to a person, place, thing, or idea of historical, cultural, 
literary, or political significance. 

Ex: 

Analogy:  a comparison in which an idea or a thing is compared to another thing that is quite 
different from it. It aims at explaining that idea or thing by comparing it to something that is 
familiar. Metaphors and similes are tools used to draw an analogy.  

Ex: 

 

Anecdote: a short and amusing or interesting story about a real incident or person. 

Ex: 

 

Antagonist: the opposing force that brings conflict and is instrumental in the development of 
the protagonist, or main character.  

Ex: 

 



Aside: A term used in drama and theater, an aside happens when a character's dialogue is 
spoken but not heard by the other actors on the stage.  An aside is typically a quick, short 
statement.  

Ex: 

 

Connotation: a meaning that is implied by a word apart from the thing which it describes 
explicitly. (Words carry cultural and emotional associations or meanings, in addition to their 
literal meanings or denotations.) 

Ex: 

 

Denotation: refers to the literal, dictionary definition of a word. 

Ex: 

 

Diction: word choice. 

Ex: 

 

Double Entendre: literary device that can be defined as a phrase or a figure of speech that 
might have multiple senses, interpretations, or two different meanings, or which might be 
understood in two different ways. Often, a double entendre will include an innuendo as one of 
the interpretations.   

Ex: 

 

Euphemism: refers to polite, indirect expressions that replace words and phrases considered 
harsh and impolite, or which suggest something unpleasant.  

Ex:​ ​ ​  

Exposition: the writer's way to give background information to the audience about the setting 
and the characters of the story. 

Ex: 

 

Foreshadow: literary device in which a writer gives an advance hint of what is to come later in 
the story.  It often appears at the beginning of a story, or a chapter, and helps the reader develop 
expectations about the coming events in a story. 

Ex: 

 

Hyperbole: from a Greek word meaning “excess,” it is a figure of speech that uses extreme 
exaggeration to make a point or show emphasis. It is the opposite of understatement. 



Ex: 

 

Idiom: refers to a set expression or a phrase comprising two or more words. An interesting fact 
regarding the device is that the expression is not interpreted literally. The phrase is understood 
to mean something quite different from what individual words of the phrase would imply.  It is 
also known as a figure of speech. 

Ex: 

 

Irony: There are three types of irony.  Verbal (also known as sarcasm): the use of words to mean 
something different than what they appear to mean.  Situational: the opposite of an expected 
outcome occurs.  Dramatic: the audience knows what will happen before the characters.  

Ex: 

 

Juxtaposition: a literary technique in which two or more ideas, places, characters, and their 
actions are placed side by side in a narrative or a poem, for the purpose of developing 
comparisons and contrasts. 

Ex: 

 

Malapropism: the mistaken use of a word in place of a similar-sounding one, often with 
unintentionally amusing effect. 

Ex: 

 

Metaphor: a figure of speech that makes an implicit, implied, or hidden comparison between 
two things that are unrelated, but which share some common characteristics. In other words, a 
resemblance of two contradictory or different objects is made based on a single or some 
common characteristics. 

Ex: 

 

Monologue: a typically long speech spoken by a single character but addressed to the other 
characters on stage. 

Ex:  

 

Motif: any recurring element that has symbolic significance in a story. Through its repetition, 
a motif can help produce other narrative (or literary) aspects such as theme or mood. 

Ex: 

Onomatopoeia: a word that sounds like the common sound of the object it is describing. 



Ex: 

Oxymoron: a figure of speech in which two opposite ideas are joined to create an effect. The 
common oxymoron phrase is a combination of an adjective proceeded by a noun with 
contrasting meanings 

Ex: 

 

Paradox: a statement that contradicts itself and still seems true somehow. 

Ex: 

 

Parody: an imitation of a writer, artist, subject, or genre in such a way as to make fun of or 
comment on the original work. Parodies are often exaggerated in the way they imitate the 
original in order to produce a humorous effect. 

Ex: 

 

Personification: a form of figurative language in which something that is not human is given 
human characteristics. This device is often used in poetry to enhance the meaning and beauty of 
poems 

Ex: 

 

Plot: a literary term used to describe the events that make up a story, or the main part of a story. 
These events relate to each other in a pattern or a sequence.  

Ex: 

 

Protagonist: the central character or leading figure in poetry, narrative, novel or any other story. 

Ex: 

 

Pun: A play on words that produces a humorous effect by using a word that suggests two or 
more meanings, or by exploiting similar sounding words that have different meanings. 

Ex: 

Sarcasm: a form of verbal irony that mocks, ridicules, or expresses contempt.  It is a Latin word 
that translates as “to tear the flesh.”  

Ex: 

 

Satire: a technique employed by writers to expose and criticize foolishness and corruption of an 
individual or a society, by using humor, irony, exaggeration, or ridicule. 



Ex: 

 

Simile: a figure of speech that makes a direct comparison, showing similarities between two 
different things. A simile draws resemblance with the help of the words “like” or “as.”  

Ex: 

 

Soliloquy: monologue given by a character in a play who is usually alone on the stage. During 
a soliloquy, a character might reveal key thoughts, feelings, and opinions to the audience 
members.  However, other characters in the play do not hear the soliloquy (even in the rare 
cases that other characters are on stage).   

Ex: 

Symbol: a literary device that contains several layers of meaning, often concealed at first sight, 
and is representative of several other aspects, concepts or traits than those that are visible in the 
literal translation alone.   

Ex: 

Syntax: the way in which words and sentences are placed together in the writing. Usually in the 
English language the syntax should follow a pattern of subject-verb-object agreement but 
sometimes authors play around with this to achieve a lyrical, rhythmic, rhetoric or questioning 
effect. 

Ex: 

Theme:  the central topic of a text. Themes can be divided into two categories: a work's thematic 
concept is what readers "think the work is about" and its thematic statement being "what the 
work says about the subject".  A text may have several themes.  

Ex: 

Understatement:  

 a figure of speech employed by writers or speakers to intentionally make a situation seem less 
important than it really is. An understatement is opposite to hyperbole, which is an 
overstatement. 

Ex: 

 

 

​ Check when completed  
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